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1. Introduction

NXP provides a complete Bluetooth® LE solution that
enables you to create applications that support up to
eight simultaneous connections using the KW36/35

SoC, which can be configured as either a central device

or a peripheral device. This application note describes
the procedure to enable multiple connections on a

Bluetooth LE peripheral device using the Temperature

Sensor

demo application.

2. Prerequisites

These items are required to complete the

implementation of multiple connections on a peripheral

device:

At least 3 FRDM-KW36 modules
FRDM-KW36 SDK package

MCUXpresso IDE

Temperature Collector demo application
Temperature Sensor demo application
TeraTerm or any other serial terminal software

© 2019 NXP B.V.
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Enabling multiple connections on Bluetooth LE peripheral device

3. Enabling multiple connections on Bluetooth LE
peripheral device

This section shows how to enable multiple connections using the Temperature Sensor application and
MCUXpresso IDE.

3.1. Creating workspace and importing SDK to MCUXpresso IDE

1. Download the FRDM-KW36 SDK at https://mcuxpresso.nxp.com/en/select?device=FRDM-
KW36.

2. Open the MCUXpresso IDE.
3. Create or select the workspace directory and click the OK button.

@ Eclipse Launcher pad

Select a directory as workspace

MCUXpresso IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: | CAKW36_MultiConn| ~ Browse...

[ Use this as the default and do not ask again

» Recent Workspaces

Figure 1. Selecting workspace

4. If there is no previous SDK installed, import the FRDM-KW36 SDK. To install a new SDK in
the MCUXpresso IDE, drag and drop the SDK .zip file into the Installed SDKSs view.

) Installed SDKs 5 = @&|lEE-=10

& Installed SDKs

To install an SDK, simply drag and drop an SDK (zip file/folder) into the ‘Installed SDKs' view.

Name SDK Version Manifest Version  Location

Figure 2. MCUXpresso “Installed SDKs” view
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Enabling multiple connections on Bluetooth LE peripheral device

5. When installed, the MCUXpresso IDE looks as Figure 3.

38 KW36_MultiConn - Develop - Welcome page - MCUXpresso IDE
File Edit Navigate Search Project Run FreeRTOS Window Help

— X
IOvH@ DR H 0 R~ |®® P iFEII | PIBNEDRSR(PIERDRNSIL AT r oDy [auick Access] | 55 |[&:
B Project Explorer &2 %, Peripherals+ iif Registers & Symbol Viewer = 0 @ Welcome 2 =0

Sl @[ Wy 7 oo @ o [file//C/NXPMCUXpressolDE_10.1.1_606/ide/pages/registeredFreeEdition htm v\ >
x IDE
MCUXpresso IDE (Free Edition) is fully activated
Welcome to MCUXpresso IDE (Free Edition). The software is now fully activated, and can be used for production.
MCUXpresso (Free Edition) can be used to generate and downioad applications with no size limit
Product Documentation
The MCUXpresso IDE User Guide provides instructions for using MCUXpresso. This is also available from the Help menu:
» Help->MCUXpresso User Guide
Further product documentation is provided within the MCUXpresso IDE via the Help menu:
= Help->Help Contents
U Quickstart Panel | ©=Global Variables (3=Variables ® Breakpoints {2 Outline =B
MCUXpresso IDE (Free Edition)
@ Installed SDKs 52 1 Pro Measurement Tool @ 3| =a
~ Start here N
B New project @ Installed SDKs
B import SDK example(s). To install an SDK, simply drag and drop an SDK (zip file/folder) into the 'Installed SDKS' view.
® Import project(s) from file system.. Name SDK Version Manifest Version  Location
a # SDK_2.x_FRDM-KW36 220 310 [} \SDK_2.2.0_FRDM-KW3¢
4
¥
*
®
3B i Cottinnes

Figure 3. MCUXpresso IDE main screen

3.2. Importing SDK example

1. Inthe Quickstart Panel tab, click the Import SDK example(s)... option.

" Quickstart Panel | ®9-Global Variables -Variables ®e Breakpoints 0= Quiline = g

MCUXpresso IDE (Free Edition) .
~ Start here

& New project..

& import SDK examplefs)...

& Import project(s) from file system...

i)
'

e

.

B

B il Cattinac .~

Figure 4. “Quickstart Panel” tab
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Enabling multiple connections on Bluetooth LE peripheral device

2. Select the frdmkw36 SDK in the Available boards screen and click the Next > button.

B sDK Import Wizard

O X
@ Importing project(s) for device: MKW36Z512x0¢4 using board: FRDM-KW36 x @

. Board and/or Device selection page

~ SDK MCUs Available boards B 2
MCUs from installed SDKs Please select an available board for your project.
NXP MKW36Z512xxx4 Supported boards for device: MKW36Z512xxx4 ‘
~ KW3x
MKW36Z5 12004

frdmkw36
Selected Device: MKW36Z5 12004 using board: FRDM-KW36 SDKs for selected MCU
Target Core: cortex-mOplus Name SDK Versi.. Manifest.. Location
Description: 41 SDK_2.x_FRDM-KW36 2.2.0 3.1.0 [E, <Default Location>\SDK_2.;

KW36Z: Kinetis KW36Z - 24 GHz BLE and Generic FSK
connectivity Wireless Radio Microcontroller (MCU) based

Figure 5. SDK import wizard
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Adding multiple connection support

3. Inthe Examples view, expand the wireless_examples folder, expand the bluetooth subfolder,
and then the temp_sens subfolder. Tick the freertos option and click the Finish button.

B8 sDK Import Wizard m] X

s The source from the SDK will be copied into the workspace. ‘ k &

If you want to use linked files, please unzip the 'SDK_2.x_FRDM-KW36' SDK.
. Import projects
Project name prefix: | frdmkw36_ /7 | Project name suffix:

Use default location

CAKW36_MultiConn\frdmkw36_ Browse...
Project Type Project Options
@ C Project | C++ Project () C Static Library () C++ Static Library SDK Debug Console @ Semihost () UART

Copy sources
Import other files

Examples | 7 M % ®E

‘ type to filter ‘

Name Version Q
I:‘ = otac_att
I:‘ £ otac_|2cap
£ otas
proxi_rep
= pulse 02 s
run_scs
temp_coll
temp_sens
bm

<

A

000 000 000 OO0 OO0 OO

BIC]

freertos
I:‘ = W_pwr_pru
I:‘ = w_pwr_ptu
D = w_uart

[ ]1E framework v

@) < Back Next > Cancel

Figure 6. Importing Temperature Sensor project to workspace

4. Adding multiple connection support

When the Temperature Sensor application is imported to the MCUXpresso IDE, the following files must
be modified to enable multiple connections: app_preinclude.h, temperature_service.c,
temperature_interface.h, and temperature_sensor.c.

4.1. Modifying app_preinclude.h file

1. Inthe Project Explorer view, expand the Temperature Sensor project and locate the
app_preinclude.h file in the source folder.

Multiple Connections in Bluetooth LE Peripheral Device, Application Note, Rev. 0, 05/2019
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Adding multiple connection support

[25 Project Explorer 32 | % Peripherals+ !4 Registers % Symbol Viewer = B8
S RGEN R
~ 8 frdmkw36_wireless_examples_bluetooth_temp_sens_freertos ~
> #¥ Binaries
> & Includes
» 3 CMSIS
» 2 bluetooth
» 2 board
» &3 drivers
» 2 framework
» 3 freertos
+ [ source
> (= common
> |g app_config.c
> [n app_preinclude.h
> [n FreeRTOSConfig.h
> [H gatt_db.h
> [H gatt_uuid128.h
> g mtb.c
» [€ semihost_hardfault.c
> €] temperature_sensor.c
> [n temperature_sensor.h
MKW36Z512xxd_connectivity.ld

o e

Figure 7. app_preinclude.h file

2. Add the following define. This define determines the maximum number of simultaneous
connections. The maximum number of connections is eight.
/*! Ak hkhkhkhkhkhkhkkhhkhhhkhkhAhhhkkhhkhhhkhkhhhhdhhkhrhhkhkhhrhhkhhkrhhkhkhhhhkdhhkhrhhkhkhkhhhkkhhkhrhrhkkhkhkhrhkhkkhhhrrhkkhhxhkhk*x

* App Configuration
R R I b I b Ih b b Sh b S Sh e S b b S S S S db b IR S b S Sb e Ib b I 2h S b b b b I SE S b Sb b I b S b b b b b b I 2h b S Sb b b b Sh  Sh b S 2b b 2 */

/*! Number of connections supported by the application */
#define gAppMaxConnections c 8

3. Locate the grmrstackrimers_c define and modify it as shown below. This define must be
increased by one for each device to be connected with pairing.

#define gTmrStackTimers c (6 + gAppMaxConnections c)

4. 1f debug is required, modify the following macro to disable the usage of the low-power mode.

/* Enable/Disable PowerDown functionality in PwrLib */
#define cPWR UsePowerDownMode 0

Multiple Connections in Bluetooth LE Peripheral Device, Application Note, Rev. 0, 05/2019
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Adding multiple connection support

4.2. Modifying temperature_service.c file

1. Inthe Project Explorer view, expand the Temperature Sensor project and locate the
temperature_sensor.c file in the bluetooth/profiles/temperature folder.

[25 Project Explorer 2 | ‘& Peripherals+ & Registers £ Symbol Viewer = B8
T

~ 8 frdmkw36_wireless_examples_bluetooth_temp_sens_freertos ~
#% Binaries
i Includes
2 CMSIS
2 bluetooth

= controller

(= hci_transport

= host
v (= profiles

= battery
= device_info
v = temperature
temperature_interfaceh
le temperature_service.c

2 board
2 drivers
2 framework
2 freertos
2 source
2 startup
2 utilities

PN S T

<

Figure 8. temperature_service.c file

2. Locate the static deviceId t mTms_SubscribedClientId declaration and comment the line.

/*! Temperature Service - Subscribed Client*/
//static deviceId t mTms_SubscribedClientId;

3. Locate the Hts_SendTemperatureMeasurementNotification function declaration and modify it as
follows:

static void Hts_SendTemperatureMeasurementNotification (tmsConfig t *pServiceConfig,
uintl6 t handle);

4. Go to the Tms_start function and modify it as follows:

bleResult t Tms_Start (tmsConfig t *pServiceConfig)

{
uint8 t mClientId = 0;

/* reset all slots for valid subscribers */
for (mClientId = 0; mClientId < pServiceConfig->validSubscriberListSize;
mClientId++)

{
pServiceConfig->avValidSubscriberList[mClientId] = FALSE;

}

return Tms_ RecordTemperatureMeasurement (pServiceConfig);

Multiple Connections in Bluetooth LE Peripheral Device, Application Note, Rev. 0, 05/2019
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Adding multiple connection support

5. Gotothe Tms_stop function and modify it as follows:

bleResult t Tms_Stop (tmsConfig t *pServiceConfig)

{
uint8 t mClientId = 0;

/* reset all slots for valid subscribers */
for (mClientId = 0; mClientId < pServiceConfig->validSubscriberListSize;

mClientId++)

{
pServiceConfig->avValidSubscriberList[mClientId] = FALSE;

}

return gBleSuccess c;

}

6. Go to the Tms_subscribe function and modify it as follows:
bleResult t Tms_Subscribe (tmsConfig t *pServiceConfig, deviceld t deviceld)
{

if (devicelId >= pServiceConfig->validSubscriberListSize)

{

return gBleInvalidParametep_c;

}

pServiceConfig->avValidSubscriberList[deviceId] = TRUE;

return gBleSuccess c;

}
7. Go to the Tms_unsubscribe function and modify it as follows:

bleResult t Tms_Unsubscribe (tmsConfig t *pServiceConfig, deviceId t deviceId)

{

if (devicelId >= pServiceConfig->validSubscriberListSize)

{

return gBleInvalidParamete;_c;

}

pServiceConfig->avValidSubscriberlList[deviceId] = FALSE;
return gBleSuccess c;

}
8. Gotothe Tms_RecordTemperatureMeasurement function and modify it as follows:

bleResult t Tms_RecordTemperatureMeasurement (tmsConfig t *pServiceConfig)
{

uintl6_t handle;

bleResult t result;

bleUuid t uuid = Uuidl6 (gBleSig Temperature d);

/* Get handle of Temperature characteristic */
result = GattDb FindCharValueHandlelInService (pServiceConfig->serviceHandle,

gBleUuidTypel6 c, &uuid, &handle);

if (result != gBleSuccess c)
return result;

/* Update characteristic value */
result = GattDb WriteAttribute (handle, sizeof (uintlé t), (uint8 t*)e&pServiceConfig-

>temperature) ;
if (result != gBleSuccess c)

return result;

Multiple Connections in Bluetooth LE Peripheral Device, Application Note, Rev. 0, 05/2019
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Adding multiple connection support

Hts SendTemperatureMeasurementNotification (pServiceConfig, handle);

return gBleSuccess c;

9. Gotothe Hts_SendTemperatureMeasurementNotification function and modify it as follows:

static void Hts_SendTemperatureMeasurementNotification (tmsConfig t *pServiceConfig,
uintl6 t handle)

{
uintl6é t hCccd;
bool t isNotificationActive;
uint8 t mClientId = 0;

/* Get handle of CCCD */

if (GattDb FindCccdHandleForCharValueHandle (handle, &hCccd) != gBleSuccess c)
return;
for (mClientId = 0; mClientId < pServiceConfig->validSubscriberListSize;
mClientId++)

{
if (pServiceConfig->avValidSubscriberList [mClientId])

{

if (gBleSuccess c¢ == Gap CheckNotificationStatus
(mClientId, hCccd, &isNotificationActive) &&
TRUE == isNotificationActive)

GattServer SendNotification(mClientId, handle);

Multiple Connections in Bluetooth LE Peripheral Device, Application Note, Rev. 0, 05/2019
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Adding multiple connection support

4.3. Modifying temperature_interface.h file

1. Inthe Project Explorer view, expand the Temperature Sensor project and locate the
temperature_interface.h file in the bluetooth/profiles/temperature folder.

25 Project Explorer 2 | %, Peripherals+ 1t Registers % Symbol Viewer = a
L
~ (25 frdmkw36_wireless_examples_bluetooth_temp_sens_freertos ~
# Binaries
! Includes
= CMSIS
~ (2 bluetooth
= controller
(= hci_transport
= host
v = profiles
(= battery
= device_info
v [= temperature
temperature_interface.h
L€ temperature_service.c
= board
& drivers
& framework
= freertos
[ source
& startup
= utilities

PN Y R,

Figure 9. temperature_interface.h file

2. Locate the structure and modify it as follows:

/*! Temperature Service - Configuration */
typedef struct tmsConfig tag
{

uintl6e t serviceHandle;

intlé6 t temperature;

bool t* aValidSubscriberList;
uint8 t validSubscriberListSize;

} tmsConfig t;

3. Locate the Tms_subscribe function declaration and modify it as follows:
bleResult t Tms_Subscribe (tmsConfig t *pServiceConfig, deviceld t deviceId);

4. Locate the Tms_unsubscribe function and modify it as follows:

bleResult t Tms_Unsubscribe (tmsConfig t *pServiceConfig, deviceId t deviceld);

5. Locate the Tms_RecordTemperatureMeasurement function and modify it as follows:

bleResult t Tms_RecordTemperatureMeasurement (tmsConfig t *pServiceConfig);

Multiple Connections in Bluetooth LE Peripheral Device, Application Note, Rev. 0, 05/2019
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Adding multiple connection support

Modifying temperature_sensor.c file

In the Project Explorer view, expand the Temperature Sensor project and locate the
temperature_sensor.c file in the source folder.

[25 Project Explorer 2 | 'z, Peripherals+ i Registers &. Symbol Viewer - o
I E
~ 5 frdmkw36_wireless_examples_bluetooth_temp_sens_freertos ~
# Binaries
= Includes
£ CMSIS
& bluetooth
& board
2 drivers
= framework
2 freertos
~ [ source
= common
lel app_config.c
app_preinclude.h
FreeRTOSConfig.h
gatt_db.h
gatt_uuid128.h
Lel mtb.c
Le| semihost_hardfault.c
\el temperature_sensor.c
temperature_sensor.h
5 MKW36Z51 2004 _connectivity.ld

P B,

Figure 10. temperature_sensor.c file

Locate the mpeerpDevicerd Vvariable declaration and modify it as follows:

static devicelId t mPeerDeviceld[gAppMaxConnections c] = {gInvalidDeviceId c};

Create a global variable to be used to track the number of active devices. This variable can be
placed below the mPeerDeviceId[gAppMaxConnections_c] declaration.

uint8 t mActiveConnections = 0;

Create a global variable to be used as a valid client list. This variable can be placed below the
basValidClientList[gAppMaxConnections_c] declaration.
static bool t tmsValidClientList[gAppMaxConnections c] = {FALSE};

Locate the tmsserviceconfig Variable and modify it as follows:

static tmsConfig t tmsServiceConfig = {service temperature, 0, tmsValidClientList,
gAppMaxConnections c};

Locate the declaration of the pisconnectTimercallback function and comment the lines as

shown below. Find the declaration within the #if - #endif preprocessor directive.

/* Timer Callbacks */

#if (cPWR_UsePowerDownMode)

static void AdvertisingTimerCallback (void *);
//static void DisconnectTimerCallback (void* ) ;
#endif

Go to the Bleapp_start function and modify the i r statement as follows:

if (mActiveConnections < gAppMaxConnections c)

Multiple Connections in Bluetooth LE Peripheral Device, Application Note, Rev. 0, 05/2019
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Adding multiple connection support

8. Go to the Bleapp config function, locate the tmsserviceconfig.initialTemperature Value
assignation, and modify it as follows:

tmsServiceConfig.temperature = 100 * BOARD GetTemperature();

9. Gotothe Bleapp AdvertisingCallback function, locate the #ifdef MULTICORE HOST preprocessor
directive, and modify it as follows:

#ifdef

f#felse

#endif

MULTICORE HOST

#if gErpcLowPowerApiServicelIncluded c
PWR7ChangeBlackBoxDeepSleepMode(3);

#endif

if (mActiveConnections > 0)

{
PWR ChangeDeepSleepMode (1) ;

PWR ChangeDeepSleepMode (3) ;

10. Go to the BleApp ConnectionCallback function.

a.

At case gConnEvtConnected c, locate and modify the following line as follows:

1) mPeerDevicelId[mActiveDevices] = peerDeviceld;

2) Tms_ Subscribe (&étmsServiceConfig, peerDeviceld);

Al case gConnEvtConnected c, add the following line below the Tms_Subscribe function
call:

mActiveConnections++;

At case gConnEvtDisconnected c, locate and modify the following line as follows:

1) mPeerDeviceld[peerDevicelId] = gInvalidDeviceId c;

2) Tms_Unsubscribe (&tmsServiceConfig, peerDeviceld);

At case gConnEvtDisconnected c, add the following line below the Tms_Unsubscribe
function call:

mActiveConnections--;

At case gConnEvtDisconnected c, lOcate the #if (cPWR UsePowerDownMode) Preprocessor
directive and modify it as follows:

#if (cPWR_UsePowerDownMode)

/* Go to sleep */

#ifdef MULTICORE HOST
#if gErpcLowPowerApiServicelncluded c

PWR_ChangeBlackBoxDeepSleepMode(3);

#endif

f#else
if (mActiveConnections > 0)
{

PWR ChangeDeepSleepMode (1) ;

}

Multiple Connections in Bluetooth LE Peripheral Device, Application Note, Rev. 0, 05/2019
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Testing peripheral device with multiple connections

else
{
PWR ChangeDeepSleepMode (3) ;
}
#endif
LedlOff () ;
f#else
LED TurnOffAllLeds();
LED StartFlash(LED ALL);
#endif

11. Go to the pisconnectTimercallback function and comment the lines as follows:

/ *
static void DisconnectTimerCallback (void* pParam)
{

if (mPeerInformation.deviceId != gInvalidDeviceId c)

{

Gap_Disconnect (mPeerDeviceId) ;

}

}

*/

12. Go to the Bleapp_sendTemperature function and modify it as follows:

static void BleApp SendTemperature (void)
{
TMR StopTimer (appTimerId) ;

/* Update with initial temperature */
tmsServiceConfig.temperature = BOARD GetTemperature() * 100;
Tms RecordTemperatureMeasurement (&tmsServiceConfig) ;

/*
#if (cPWR UsePowerDownMode)
Start Sleep After Data timer
TMR StartLowPowerTimer (appTimerId,
gTmrLowPowerSecondTimer c,
TmrSeconds (gGoToSleepAfterDataTime c),
DisconnectTimerCallback, NULL);
#endif
*/

Multiple Connections in Bluetooth LE Peripheral Device, Application Note, Rev. 0, 05/2019
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5. Testing peripheral device with multiple connections

The Temperature Collector demo application is needed together with the Temperature Sensor demo
application to demonstrate the functionality of multiple connections. The following steps show how to
generate two (or more) central devices enabled with the Temperature Collector to test multiple
connections in a peripheral device.

5.1. Importing Temperature Collector example

1. See Section 3.2, “Importing SDK example” and follow the steps described there. In step number
3, select temp_coll instead of temp_sens. This imports the Temperature Collector demo
application into the workspace.

SDK Import Wizard m} %

 The source from the SDK will be copied into the warkspace. ‘ k é/

If you want to use linked files, please unzip the 'SDK_2x_FRDM-KW36' SDK.
. Import projects
Project name prefix: | frdmkw36_ /7 | Project name suffix:

Use default location

CAKW3b_MultiConn\frdmkw36_ Browse...
Project Type Project Options
@ C Project ) C++ Project () C Static Library ) C++ Static Library SDK Debug Console @) Semihost () UART

Copy sources
Import other files

Examples | 2 M %| B B

‘ type to filter ‘

Name Version 2
I:‘ = otac_l2cap
I:‘ = otas
I:‘ £ proxi_rep
I:‘ = pulse_o2_s
I:‘ = run_scs
~ IE‘ = temp_coll
D bm
freertos
I:‘ £ temp_sens
I:‘ = w_pwr_pru
I:‘ = w_pwr_ptu
I:‘ = w_uart
[]& framework
|—| £ genfsk v

‘/?3‘ < Back Next > Cancel

Figure 11. Importing Temperature Collector project to workspace

2. The Temperature Collector application has the low-power mode enabled by default and, like the
Temperature Sensor application, it has a timer that disconnects the device when the temperature
is reported. To avoid disconnection, perform these steps:

a) Open the Temperature Collector application’s app_preinclude.h file and modify the

Multiple Connections in Bluetooth LE Peripheral Device, Application Note, Rev. 0, 05/2019
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Testing peripheral device with multiple connections

following macro to disable the low-power mode:

/* Enable/Disable PowerDown functionality in PwrLib */

#define cPWR UsePowerDownMode 0

b) Open the Temperature Collector application’s temperature_collector.c file, navigate to
the Bleapp GattNotificationCallback function, and modify the following lines:
/*
#if (cPWR UsePowerDownMode)
Restart Wait For Data timer
TMR StartLowPowerTimer (mAppTimerId,
gTmrLowPowerSecondTimer c,
TmrSeconds (gWaitForDataTime c),
DisconnectTimerCallback, &serverDeviceld);

#endif
*/
3. If debugging is required, open the Temperature Collector application’s app_preinclude.h file and
modify the following macro to disable the low-power mode.

/* Enable/Disable PowerDown functionality in PwrLib */

#define cPWR UsePowerDownMode 0

5.2. Building and downloading projects

1. Select the Temperature Sensor project in the Project Explorer view and compile it by clicking
the Build button in the Quickstart Panel view.
[ Project Ex.. 2 % Peripheral.. % Registers &1SymbolVi.. = O
DlE @ @ ~

=% frdmkw36_wireless_examples_bluetooth_temp_coll_freertos
=% frdmkw36_wireless_examples_bluetooth_temp_sens_freertos

Figure 12. Temperature Sensor project selected

Multiple Connections in Bluetooth LE Peripheral Device, Application Note, Rev. 0, 05/2019
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Testing peripheral device with multiple connections

U Quickst.. ®=Global .. =Variables ® Breakp.. 3= Outline = B

MCUXpresso IDE (Free Edition)

~ Start here
B New project...
= Import SDK example(s)...

& Import project(s) from file system...

A Build ‘frdmkw36_wireless_examples_bluetooth_temp_sens_freertos I

& Clean ‘frdmkw36_wireless_examples_bluetooth_temp_sens_freertos

¥ Debug ‘frdmkw36_wireless_examples_bluetooth_temp_sens_freertc

14

® rdit frdmkw36_wireless_examples_bluetooth_temp_sens_freertas”’|
& Quick Settings>>

] Export project(s) to archive (zip) w7

Figure 13. Build project button

2. Connect the FRDM-KW36 module, which acts as the temperature sensor and wait for the drivers
to be installed.

3. When the drivers are installed, make sure that the Temperature Sensor project is still selected and

download the code to the FRDM-KW36 board by clicking the Debug button in the Quickstart
Panel view.

@ Quickst.. ®=Global .. W=Variables ® Breakp.. 3= Outline = O

MCUXpresso IDE (Free Edition)

~ Start here

B New project...

. Import SDK example(s)...

& Import project(s) from file system...

% Build ‘frdmkw36_wireless_examples_bluetooth_temp_sens_freertos

& Clean ‘frdmkw36 wireless exa_mples bluetooth temp sens_freertos

I W Debug ‘frdmkw36_wireless examples_bluetooth_temp_sens_freertc I

v

e

® Edit frdmkw36_wireless_examples_bluetooth_temp_sens_freertas’|
& Quick Settings>>

] Export project(s) to archive (zip) 2
£ >
Figure 14. Build project button
4. Stop the debugger by clicking the Terminate button and disconnect the board.

. KW36_MultiConn - Develop - frdmkw36_wireless_examples_bluetooth_temp_coll_freertos/framework/OSAbstraction/Source/fsl_os_abstraction_free_rtos.c - MCUXpresso IDE
File Edit Source Refactor Navigate Search Project Run FreeRTOS Window Help

SOl B R -RiFEE-O-A OO P ARE @ N ﬂ@.@ulﬁ:..\uwu LRRIGILAIEFH O E o~

Figure 15. Terminate button
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Testing peripheral device with multiple connections

5. Repeat the previous steps for the remaining boards that act as temperature collectors. Make sure
that the Temperature Collector project is selected.

[25 Project Ex... 2 |2 Peripheral... i Registers £ SymbolVi.. = O
=g @ @ -

=% frdmlkw36_wireless_examples_bluetooth_temp_coll_freertos
=% frdmkw36_wireless_examples_bluetooth_temp_sens_freertos

Figure 16. Temperature collector project selected

5.3. Running application

1. Connect the FRDM-KW36 boards flashed with the Temperature Collector application.
2. Launch TeraTerm and open the port assigned to the FRDM-KW36 board.

Tera Term: New connection K

OTCPIP myhost.example.com

History

22

Telnet

SSH SSH2

Other

UNSPEC
@® Serial Port: COM36: USB Serial Device (COM36) v
Cancel Help

Figure 17. Opening serial port

3. Open the Setup menu and select the Serial port option. Make sure to configure the settings as in
Figure 18.
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Tera Term: Serial port setup

Port:
Baud rate:
Data:
Parity:
Stop:

Flow control:

COM18 oK
115200 ‘|

8 bit v Cancel
none

1 bit v ‘ Help
none

Transmit delay

0 msecichar 0 mseciline

Figure 18. Configuring serial port

Press the Reset (SW1) button on the FRDM-KW36 board. The Temperature Collector displays
the screen shown in Figure 19.

T COM36 -

Tera Term VT

File Edit Setup Control Window

#

11212 2 U 2 402
BHBHGE BN
fi2it dinieiiidi

## 4
#an

Help

HuHiE HuEgEHERnNg

nuHus H
L2 02

# Hu #unne o

SHELL build: Sep 21 2018
Copyright {(c> 2016 NXP Semiconductors
BLE Temp Collector>
Press SCANSYW to connect to a Temperature Sensort

Figure 19. Temperature collector

Open the File menu and select the New connection option. Open the port of the remaining
Temperature Collector boards and repeat steps 3 and 4.
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Tera Term: New connection X

OTCPIP nyhost.example.com

History

22

lelnet

SSH SSH2

Other

UNSPEC
® Serial Port: COM39: JLink CDC UART Port (COM39) ~
Cancel Help

Figure 20. Opening serial port

6. Connect the Temperature Sensor board and press the SW2 button to start advertising. When all
the connections are established, the SW2 button can be used to send additional temperature
reports.

7. Press the SW2 button on any Temperature Collector board to start scanning. When the
Temperature Sensor is connected, the Temperature Collector shows the temperature reported by
the sensor.

1 COM36 - Tera Term VT - O *

Eile Edit Setup Control Window Help
LR T iy A

HUEBHE HHUS
p2idiaitiyieed

HuHHg #

SHELL build: Sep 21 2818
Copyright <(c)> 2016 NRXP Semiconductors
BLE Temp Collector>

Press SCANSW to connect to a Temperature Sensor?

Scanning...

Temperature: 21 C
Figure 21. First Temperature Collector connected

8. Repeat steps 6 and 7 with the remaining boards. Each time the Temperature Sensor sends a
temperature report, it is shown simultaneously on each Temperature Collector.
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T COM36 - Tera Term VT

File Edit Setup Control Window Help
isigiedisieied Hiti itk

i RN B !
B HEHEE HHER
Hii bididisitieieisid
13180313

12180013

1381213 Hunng #

SHELL build: Sep 21 2818
Copyright <(c)> 2016 NRP Semiconductors
BLE Temp Collector>

Press SCANSY to connect to a Temperature Sensor?

Scanning. ..

Found device:

Temperature :
Temperature :
Temperature :
Temperature :

Figure 22. Second Temperature Collector connected

W COM39 - Tera Term VT

File Edit Setup Control Window Help

HunHy BHuw
pi2isiisiiieied
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SHELL build: Sep 21 2818
Copyright (c)> 20816 NREP Semiconductors
BLE Temp Collectow>

Press SCANSY to connect to a Temperature Sensor?

Scanning. ..

Found dewvice:
NXP_TEMP
BB6@37DE9C87
Connected?
Temperature: 23 C
Temperature: 22 C

Figure 23. Last two measurements repeated on both collectors

9. If the connection drops, each Temperature Collector shows a disconnection message.
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T COM36 - Tera Term VT
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SHELL build: Sep 21 2018
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BLE Temp Collector>
Press SCANSW to connect to a Temperature Sensor?

Temperature: 22 C

Disconnected?
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BLE Temp Collector>

Press SCANSYW to connect to a Temperature Sensor?

Scanning. ..

Found device:
NXP_TEMP
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Connected?
Temperature: 23 C
Temperature: 22 C

Disconnected?

Figure 24. Temperature Sensor disconnected from both Temperature Collectors
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